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Introduction To Calc  
Calc is the spreadsheet component of LibreOffice. Spreadsheets allow us to organize,

analyse and store data in tabular form. Furthermore in a spreadsheet we can manipulate
this data to produce certain results. Other features provided by Calc include:
•Functions, which can be used to create formulas to perform complex calculations 
on data.
•Database functions to arrange, store, and filter data.
•Dynamic charts giving a wide range of 2D and 3D charts.
•Ability to open, edit, and save Microsoft Excel spreadsheets.

Spreadsheets, Sheets, And Cells  
In Calc you create files that are called spreadsheets. A spreadsheet consist of a number 
of individual sheets, each sheet containing cells arranged in rows and columns.A 
particular cell is identified by its row number and column letter (for example cell B8).Each 
cell can contain data in the form of text, numbers or formulas.

• Maximum rows :-1,048,576 

• Maximum columns.:-1024 (AMJ) 

• Extension name:-.ods

• Minimum zooming range:-20%

• Maximum zooming range:- 400%



Create A New Spread Sheet  
step 1- go to file menu-click on new – spread sheet

or you can use shortcut key CTRL+N

Saving Spreadsheet  
step 1- go to file menu- select ‘save’ or press shortcut key CTRL+S on click on save button from 
the standard tool baar.

Step 2- if you are saving the file for the 1st time the save as dialogue box will appea.

Step 3- you have to enter the name of the file and location where you want to save the click on 
save button.

Saving Spreadsheet On Other Locations  
you can use the save as command to save the data of the spreadsheet file to a different location or 
type format or different file name.

Step – go to file menu – save as or press shortcut key CTRL+SHIFT +S -the save as dialogue box 
will appear then select the file type and select location where you want to save , then click on save 
button.

Opening And Closing Spreadsheet   
Opening:-

step 1-go to file menu- select ‘open’ orpress shortcut key CTRL+O.

Step 2-Click the open icon on standard tool bar.

Step 3-A dialoge box will appear on your screen you can slect the desired spread sheet file you 
want to open and click on open button.

Closing:-

go to file menu – select the close option.



Calc Main Window  

When Calc is started, the main window opens and the various parts are 
shown in the image below. The Menu bar, toolbars, Sidebar and Status bar 
have similar functionality with other LibreOffice components.



Spreadsheet Layout  
The main section of the workspace in Calc displays the cells in the form of a grid. 
Each cell is defined by the
intersection of one column
and one row in the
spreadsheet. At the top of the
columns and the left end of
the rows are a series
of header boxes containing
letters and numbers. The
column headers use an
alphabet character starting at
A and go on to the right. The
row headers use a numerical
character starting at 1 and go down.

Name Box And Formula Bar  
The name of the active cell is displayed in the Name box. The name of each cell is 
formed by the letter of the column and its line number. The active cell is the one we
have selected each time using the mouse or keyboard. Next to the Name Box is 
the Formula Bar that displays the formula or just the contents of a cell. In the 
Formula bar there are buttons for inserting functions into a cell. Formulas and 
functions allow us to enter calculations into a cell based on the values of other 
cells.

Sheets Bar  
In Calc you can have more than one sheet in a spreadsheet. At the bottom of the grid of 
cells in a spreadsheet the sheets bar is located, indicating how many sheets there are in 
your spreadsheet. Clicking on a sheet's tab enables access and displays to the 
workspace each individual sheet. An active sheet is indicated with a highlight color in the 
sheet's tab.



Navigating  

Cell Navigation  
You can navigate to any cell by clicking with the
mouse, however you should learn the following
navigation shortcuts keys to speed up data
entry with Calc.

•Enter key moves the cell focus down
the next row.

•Shift+Enter moves the focus up to the
previous row.

•Tab moves the cell focus right the next column.

•Shift+Tab moves the focus left the next column.

Alternatively you can navigate using the arrow keys on the keyboard or the Page Up, Page 
Down, Home and End keys.

Sheet Navigation  
Each sheet inside a spreadsheet file is independent of the other sheets, though you can refer to a 
cell from another sheet when using formulas. To navigate between different sheets in a 
spreadsheet:

•Click on one of the sheet tabs at the bottom of the spreadsheet or

•Use the Navigator tab in the Sidebar

If there are a lot of sheets in your spreadsheet, then some of the sheet tabs may be hidden behind
the horizontal scroll bar at the bottom of the screen. In this case, use the four buttons to the left of 
the sheet tabs to move the tabs into view.



Selecting  

Selecting Cells  
Single cell

To select a cell using the mouse, place the
mouse pointer over the cell and click the left
mouse button. When a cell is selected or in
focus, the cell borders are emphasized.
The cell reference name is displayed in the
Name Box in the Formula bar.

Range Of Contiguous Cells  
A range of cells can be selected using the keyboard or the mouse. The cells range name is 
displayed in the Name Box in the Formula bar. A cell range has the following syntax

<upper left cell name>:<lower right cell name>

In the example below the selected cell range is
named B3:C6

a) To select a range of cells using the mouse:

1.Select the upper left cell.

2.Press and hold down the left mouse button.

3.Move the mouse cursor to the lower right cell and release the left mouse button.

b) To select a range of cells using the SHIFT key:

1.Select the upper left cell

2.Hold down the SHIFT key.

3.Select the lower right cell.

c) You can also directly select a range of cells using the Name Box. Click into the Name Box on 
the Formula Bar and type the cells range name.



Range Of Non-Contiguous Cells  
1.Select the cell or range of cells using one
of the methods above.

2.Hold down the CTRL key

3.Using the mouse move and select the
next cell or range of cells.

4.Repeat the above step for all required selections.

Selecting Columns And Rows  

Single Column Or Row  
To select a single column or row, click
on the column or row header.

Multiple Columns Or Rows  
To select multiple columns or rows that
are contiguous:

1.Click on the first column or row in the
group.

2.Hold down the SHIFT key.

3.Click the last column or row in the group.

To select multiple columns or rows that are not
contiguous:

1.Click on the first column or row in the
group.

2.Hold down the CTRL key.

3.Click on all of the subsequent columns or rows while holding down the CTRL key.



Entire Sheet  
To select the entire sheet, click on the small box
between the column headers and the row headers, or
use the key combination CTRL+A to select the entire
sheet.

Formatting Cells  

Formating Characters  
When you click on a cell or a group of cells you
can apply character formating using the toolbar
or the Sidebar. This formatting applies to all
contents of the cell or cells.

To format part of a text in a cell double click 
inside the cell, select the text and the apply the 
formatting.

Cell Alignment  
You can align the contents of a cell both vertically
and horizontally. The results of each alignment type
are shown in the table below.

To align cells use the alignments buttons on the Formatting 
toolbar.

Or you can use the Alignment Section on the Sidebar.



Text Wrapping  
Text entered into a cell does not wrap around cell
borders. To change this behaviour you must
enable Text Wrapping on a cell or group of cells. To
enable Text Wrapping use Format > Cells… > tab
Alignment > Properties “Wrap text automatically”. 

Resizing  
You can resize the width of a column or the height of a row with one of
the following ways:

A) Dragging  
Place the mouse cursor on the edge of a
column or row header and when the resize
mouse icon appears drag to resize.

B) Using The Context Menu  
In this way you can resize multiple columns or
rows at once. Select one or more columns or
rows and right click to bring the context menu.
Select the Column Width (or Row Height)
command to bring the window to set the new size.

Type the value for the column width (or
row height).



Optimal Column Width Or Row Height.  
To quickly change the width of a
column or height of a row place the
mouse cursor on the edge of a
column or row header and double
click. The width or height will adjust
to the optimal size.

Add And Delete Rows And Columns In Calc  
It covers the following:

•Inserting Rows  

•Deleting Rows  

•Inserting Columns  

•Deleting Columns  

Inserting Rows  

1.Click a cell in a row that you want to
insert a row above or below.
2.Click the Sheet menu.
3.Highlight the Insert Rows sub-
menu.
4.Choose either Rows Above or Rows Below.

Delete Rows  
1.Click a cell in the row you wish to delete.
2.Click the Sheet menu.
3.Click the Delete Rows item.

https://oscollege.com/libreoffice-calc/add-and-delete-rows-and-columns-in-calc/#DeleteColumns
https://oscollege.com/libreoffice-calc/add-and-delete-rows-and-columns-in-calc/#InsertColumns
https://oscollege.com/libreoffice-calc/add-and-delete-rows-and-columns-in-calc/#DeleteRows
https://oscollege.com/libreoffice-calc/add-and-delete-rows-and-columns-in-calc/#InsertRows


Insert Columns  
1.Click on a cell in the column you
want to insert a new column to the left
or right of.

2.Click the Sheet menu.

3.Highlight the Insert Columns sub-menu.
4.Click either Columns Left or Columns Right.

Delete Columns  

1.Click a cell in the column you wish to delete.
2.Click the Sheet menu.
3.Click the Delete Columns item.

Merging And Splitting Cells  
You can merge two or more cells and combine
them to one. To merge select the cells and click
on the merge button. Calc will ask you if you
want to move the contents of the second cell to
the first. To split the cells back select the cells
and click again on the merge button.

Cell Borders And Background  
Using borders and background color you can format
the cells in a spreadsheet in order to change the
visual display of the data. An example of border
formatting and background color is shown in the
figure below.



Background Color  
To apply background color to a cell or a group of cells, select and then click on the 
background color button on the Formatting toolbar. When you click on the arrow in this 
button you can select another color. Using the same button you can change the color or 
remove the background color (No Fill option).

Borders  
To quickly set and style the borders around cells use the
buttons from the Formatting toolbar. Υοu can set the border
type, line style and color.

Alternatively you can use the Cell Appearance section
in the Sidebar

Operators In Formulas  
Formulas in Calc are like mathematical equations. You can use a combination of numbers, cell references 
and operators to perform from simple to complex calculations. Here we list the basic operator types 
supported in LibreOffice Calc.

Arithmetic  
Operator Name Example

+ Addition = 1 + 1

- Subtraction = 5 - 2

- Negation = -12

* Multiplication = 5 * 3

/ Division = 6 / 2

% Percent 15%

^ Exponentiation 2^3



 Functions   

Function Syntax  
The basic syntax to create a
formula with a function is:

1.Insert an equals sign (=),

2.Insert the function name (SUM, for example is the function name for addition),

3.A function normally accepts one or more arguments. Arguments contain the data
on which the function will calculate the result. In most cases, the arguments are 
references to cell areas or individual cells.

Application Of Functions

Text function:-This section contains descriptions of the Text functions. 

CONCATENATE  
Combines several text strings into one string.

Syntax  

==Concatenate(Text1,Text2,....,Text3)Concatenate(Text1,Text2,....,Text3)

I N P U TI N P U T

O U T P U TO U T P U T



LEFT  
Returns the first character from the left side.

Syntax  

=Left("Text"; Number)=Left("Text"; Number)

Text is the text where the initial partial words are to be determined.

Number (optional) specifies the number of characters for the start text. If this parameter is
not defined, one character is returned.

I N P U TI N P U T

O U T P U TO U T P U T

RIGHT  
Returns the  character from the right side. 

Syntax  

=Right("Text"; Number)=Right("Text"; Number)

Text is the text where the initial partial words are to be determined.

Number (optional) specifies the number of characters for the start text. If this parameter is
not defined, one character is returned.

I N P U TI N P U T    



O U T P U TO U T P U T

LEN  
Returns the length of a string including spaces.

Syntax  

=Len("Text")=Len("Text")

Text is the text whose length is to be determined.

I N P U TI N P U T    

O U T P U TO U T P U T



LOWER  
Converts all uppercase letters in a text string to lowercase.

Syntax  

=Lower("Text")=Lower("Text")

Text refers to the text to be converted.

I N P U TI N P U T

O U T P U TO U T P U T    

UPPER  
Converts the string specified in the text field to uppercase.

Syntax  

=Upper("Text")=Upper("Text")

Text refers to the lower case letters you want to convert to upper case.

I N P U TI N P U T    

O U T P U TO U T P U T



MID  
Returns a text string of a text. The parameters specify the starting position and the 
number of characters.

Syntax  

=Mid("Text"; Start; Number)=Mid("Text"; Start; Number)

Text is the text containing the characters to extract.

Start is the position of the first character in the text to extract.

Number specifies the number of characters in the part of the text.

I N P U TI N P U T

O U T P U TO U T P U T

PROPER  
Capitalizes the first letter in all words of a text string.

Syntax  

=Proper("Text")=Proper("Text")

Text refers to the text to be converted.

I N P U TI N P U T

O U T P U TO U T P U T



SUBSTITUTE  
Substitutes new text for old text in a string.

Syntax  

=Substitute("Text"; "Searchtext"; "Newtext")=Substitute("Text"; "Searchtext"; "Newtext")

Text is the text in which text segments are to be exchanged.

SearchText is the text segment that is to be replaced (a number of times).

NewText is the text that is to replace the text segment.

I N P U TI N P U T    

O U T P U TO U T P U T

REPEAT  
It repeats any alphanumeric text or symbol upto a number of times.

Syntax  

=Rept(Text,Number)=Rept(Text,Number)

I n p u tI n p u t

o u t p u to u t p u t



POWER  
Returns a number raised to a power.

Syntax:  
=Power(Number; Power)=Power(Number; Power)

I N P U TI N P U T

O U T P U TO U T P U T

PRODUCT  
Multiplies all the numbers given as arguments and returns the product.

Syntax:  
=Product(Number1; Number2; ... )=Product(Number1; Number2; ... )

I N P U TI N P U T

O U T P U TO U T P U T



MOD  
Returns the integer remainder of a division.

Syntax:  

=Mod(Dividend,Divisor)=Mod(Dividend,Divisor)

I N P U TI N P U T

O U T P U TO U T P U T

MAX  
Returns the maximum of a list of arguments, ignoring text entries.

Syntax  :  

=Max(Number1; Number2; ... Number30)=Max(Number1; Number2; ... Number30)

I N P U TI N P U T

O U T P U TO U T P U T



MIN  
Returns the minimum of a list of arguments, ignoring text entries.

Syntax  :  

=Min(Number1; Number2; ... )=Min(Number1; Number2; ... )

I N P U TI N P U T

O U T P U TO U T P U T

AVERAGE  
Returns the average of the arguments, ignoring text.

Syntax  :  

=Average(Number1; Number2; ...)=Average(Number1; Number2; ...)

I N P U TI N P U T

O U T P U TO U T P U T



SUM  
Adds all the numbers in a range of cells.

Syntax  :  

=Sum(Number1; Number2;...)=Sum(Number1; Number2;...)

I N P U TI N P U T

O U T P U TO U T P U T



SUMIF  

Syntax  :  

That allows you to add up the values in a range of cells that meet specific criteria. The function 
takes three arguments:

Range: The range of cells that you want to evaluate.

Criteria: The condition that cells must meet to be included in the calculation.

Sum_range: The range of cells whose values you want to add up.

=Sumif(Range, Criteria , Sum Range)=Sumif(Range, Criteria , Sum Range)

I N P U TI N P U T

O U T P U TO U T P U T



SUMIFS  
Syntax

that allows you to add up the values in a range of cells that meet multiple criteria.
The function takes multiple arguments:

1. Sum_range: The range of cells whose values you want to add up.
2. Criteria_range1: The first range of cells that you want to evaluate.
3. Criteria1: The condition that cells in the first criteria range must meet to be included in the 

calculation.
4. Criteria_range2: The second range of cells that you want to evaluate.
5. Criteria2: The condition that cells in the second criteria range must meet to be included in 

the calculation.
You can specify up to 127 pairs of criteria range and criteria.

=Sumifs(Sum_Range, Criteria_Range1, Criteria1, [Criteria_Range2, Criteria2], ...) =Sumifs(Sum_Range, Criteria_Range1, Criteria1, [Criteria_Range2, Criteria2], ...) 

I N P U TI N P U T

O U T P U TO U T P U T    



COUNT  
Syntax

=Count(Value1,Value2.......)=Count(Value1,Value2.......)
• Blank cell =  ✘
• Alphabet =  ✘
• Number =  ✓

I n p u tI n p u t o u t p u to u t p u t

COUNTA
Syntax

=Counta(Value1,Value2.......)=Counta(Value1,Value2.......)
• Blank cell =  ✘
• Alphabet =  ✓
• Number =  ✓

I n p u tI n p u t o u t p u to u t p u t



COUNTBLANK
Syntax

=Countblank(Value1,Value2.......)=Countblank(Value1,Value2.......)
• Blank cell =  ✓
• Alphabet =  ✘
• Number =   ✘

I n p u tI n p u t
••                  

o u t p u to u t p u t



COUNTIF
Syntax

=Countif(Range,Criteria)=Countif(Range,Criteria)

COUNTIF is a function in spreadsheet software, such as LibreOffice Calc, that allows you to count
the number of cells in a range that meet a specific condition.

The function takes two arguments:

Range: The range of cells that you want to evaluate.
Criteria: The condition that cells must meet to be counted.

I N P U TI N P U T

O U T P U TO U T P U T



COUNTIFS  
Syntax

=Countifs(Range1, Criteria1, Range 2, Criteria2 ..........)=Countifs(Range1, Criteria1, Range 2, Criteria2 ..........)

COUNTIFS is a function in spreadsheet software, such as LibreOffice Calc, that allows you to 
count the number of cells in a range that meet multiple criteria.
The function takes multiple arguments:

1. Range1: The first range of cells that you want to evaluate.

2. Criteria1: The condition that cells in the first criteria range must meet to be counted.

3. Range2: The second range of cells that you want to evaluate.

4. Criteria2: The condition that cells in the second criteria range must meet to be counted.

You can specify up to 64 pairs of range and criteria.

I N P U TI N P U T

O U T P U TO U T P U T



ROUND  

Syntax

=Round(Number, Count)=Round(Number, Count)

the ROUND function is a built-in mathematical function that is used to round a numeric value to a 
specified number of digits. The function takes two arguments: the number to be rounded, and the 
number of digits to which the number should be rounded. 

I N P U TI N P U T

O U T P U TO U T P U T



ROUND UP

Syntax

=Roundup(Number, Count)=Roundup(Number, Count)

In LibreOffice Calc, the ROUNDUP function is a built-in mathematical function that is used to 
round a numeric value up to a specified number of decimal places. The function takes two 
arguments: the number to be rounded, and the number of decimal places to which the number 
should be rounded up.

I N P U TI N P U T

O U T P U TO U T P U T



 ROUND DOWN

Syntax

=Rounddown(Number, Count)=Rounddown(Number, Count)

In LibreOffice Calc, the ROUNDDOWN function is a built-in mathematical function that is used 
to round a numeric value down to a specified number of decimal places. The function takes two 
arguments: the number to be rounded, and the number of decimal places to which the number 
should be rounded down. 

I N P U TI N P U T

O U T P U TO U T P U T



Comparative operators  

Operator Name Example

= Equal A1 = B1

> Greater than A1 > B1

< Less than A1 < B1

>= Greater or Equal than A1 >= B1

<= Less or Equal than A1 <= B1

AND FUNCTION  
The AND function is a logical function used to require more than one condition at 
the same time. AND returns either TRUE or FALSE. The AND function can be used
as the logical test inside the IF function.

Purpose of AND Function

Test multiple conditions with AND.

Return value

TRUE if all the conditions evaluate to TRUE, else it returns a FALSE.

Syntax  

=And (Logical1, [Logical2],….)=And (Logical1, [Logical2],….)

In the given example the return value will be TRUE if the score is less than 50 and 
90 , FALSE if not matched with the given criteria. 

I N P U TI N P U T



O U T P U TO U T P U T

OR FUNCTION  
Syntax, 

=Or(Logical1, [Logical2],...)=Or(Logical1, [Logical2],...)

In LibreOffice Calc, the OR function is a logical function that returns a Boolean 
value of TRUE or FALSE. The OR function tests whether any of a set of conditions 
are true, and returns TRUE if at least one of the conditions is true, and FALSE if 
none of the conditions are true. 

I N P U TI N P U T

O U T P U TO U T P U T



IF FUNCTION  
The IF function is one of the most popular
functions in Calc and other spreadsheet
applications. IF performs a logical test and return
one value for a TRUE result, and another for a
FALSE result. In its simplest form, the IF function
says:

IF(Something is True, then return value1,
otherwise return value2)
Returns one of two values, depending on a test condition.
Syntax  :  

=If(Test; Value1; Value2)=If(Test; Value1; Value2)  
where:
test is or refers to a logical value or expression that returns a logical value (TRUE or 
FALSE).
value1 is the value that is returned by the function if test yields TRUE.
value2 is the value that is returned by the function if test yields FALSE.
If value2 is omitted it is assumed to be FALSE; if value1 is also omitted it is assumed to 
be TRUE.

I N P U TI N P U T

In
the

Pass/Faill column he wants to display a "Pass" text if the final score is 
greater or equal to 70. Using the IF function the formula is



=IF(E4>=70,"Pass","Fail")

After the function is filled the "Pass" or "Fail" result will be displayed.

Then you can use autofill to fill the remaining cells.

O U T P U TO U T P U T



VLOOKUP  
Syntax

=Vlookup(Search Criteria, Array, Index , Sorted Range Lookup)=Vlookup(Search Criteria, Array, Index , Sorted Range Lookup)

In LibreOffice Calc, VLOOKUP is a built-in function that searches for a value in the leftmost 
column of a range or table, and returns a value in the same row from a specified column of that 
range or table. 

I N P U TI N P U T

O U T P U TO U T P U T



HLOOKUP  
Syntax

=Hlookup(Search Criteria, Array, Index , Sorted Range Lookup)=Hlookup(Search Criteria, Array, Index , Sorted Range Lookup)

In LibreOffice Calc, HLOOKUP is a built-in function that searches for a value in the top row of a 
range or table, and returns a value in the same column from a specified row of that range or table.

I N P U TI N P U T

O U T P U TO U T P U T



Cell Reference
Cell reference is the address or name of a cell or a range of cells. It is the combination of column 
name and row number. It helps the software to identify the cell from where the data/value is to be 
used in the formula. We can reference the cell of other worksheets and also of other programs. 

There are three types of cell references in
Excel: 

1. Relative reference

2. Absolute reference

3. Mixed Reference

1. Relative Reference  

Relative reference is the default cell reference in calc. It is simply the combination of column name
and row number without any dollar ($) sign.
Steps to Use Relative Reference:

Step 1: We write the formula in any cell and press enter so
that it is calculated.

Step 2: Now click on the Fill handle at the corner of
cell which contains the formula(C2).



Step 3: Drag the Fill handle up to the cells you want to fill.

2. Absolute Reference  

Absolute reference is the cell reference in which the row and column are made constant by adding 
the dollar ($) sign before the column name and row number. 

Step 1: We write the formula in any cell and
press enter so that it is calculated. In this
example, we write the
formula(=(A2+B2)*$C$2) in cell D2 and press
enter to calculate the formula.

Step 2: Now click on the Fill handle at the
corner of cell which contains the formula(D2).



Step 3: Drag the Fill handle up to the cells you want to fill.

Step 4: Now we can see that the percentage is calculated in column D.

Step 5: You can double-click on any cell to check that the operation is performed in between which
cells, and we see that the address of cell C2 does not change.



3. Mixed Reference  

Mixed Reference is a type of Absolute reference in which either the column is made constant or the
row is made constant. When we make any column or row constant then the column name or row 
number does not change as we copy the formula to other cell(s). The mixed reference is designated 
by a dollar sign($) in front of the row or column. 

Step 1: Write the formula in any cell. We write the formula(=B2+A2) in cell C2 and press enter.

Step 2: Click and hold on to the Fill handle.

Step 3: Drag it to the cell you want to fill. We drag it till cell C3.

Step 4: We did not make row 2 of column A constant, thus we see that as we copy the formula to 
cell C3, A2 changes to A3 i.e. the addition is
performed between A2 and B2, A3 and B3.

We make row 2 of column A constant by adding a
dollar sign before 2.



Step 5: Write the formula in any cell. We write the formula(=B2+A$2) in cell C2 and press enter.

Step 6: Click and hold on to the Fill handle.

Step 7: Drag it to the cell you want to fill. We drag it till cell C3.

Step 8: We made row 2 of column A constant, thus we see that as we copy the formula to cell C3, 
A2 does not change to A3 i.e. A2 is added to cell B2 and B3.



Database Function Parameters:
1. Database : is the cell range defining the database.

2. DatabaseField specifies the column where the function operates on after the 
search criteria of the first parameter is applied and the data rows are selected. It is 
not related to the search criteria itself.

3. SearchCriteria: is the cell range containing search criteria.

EXAMPLE:

DSUM  
DSUM calculates the sum of all numeric values in the cells (fields) of the specified column, 
for all rows (database records) that match the specified search criteria. Blank cells or cells 
containing non-numeric characters are not included.

Returns 0 if no matches are found, or if there are no numeric values in the cells of the 
specified column for the matching records.

Syntax  

DSUM(Database; DatabaseField; SearchCriteria)

INPUTINPUT



OUTPUTOUTPUT

DAVERAGE  
DAVERAGE calculates the average of the numeric values in the cells (fields) of 
the specified column, for all rows (database records) that match the specified 
search criteria. Non-numeric values in those cells are ignored.

Returns a #DIV/0! error if no records match the specified search criteria, or if there are no numeric 
values in the cells of the specified column for the matching records.

Syntax  

DAVERAGE(Database; DatabaseField; SearchCriteria)

DCOUNT  
DCOUNT counts the number of cells (fields) of the specified column that contain numeric values, 
for all rows (database records) that match the specified search criteria. However, if no column is 
specified, DCOUNT returns the count of all records that match the specified search criteria 
irrespective of their contents.

Syntax  

DCOUNT(Database; DatabaseField; SearchCriteria)



DMAX  
DMAX calculates the maximum value across the cells (fields) of the specified column that contain 
numeric values, for all rows (database records) that match the specified search criteria. Blank cells 
or cells containing non-numeric characters are not included.

Returns 0 if no matches are found, or if there are no non-zero numeric values in the cells of the 
specified column for the matching records.

Syntax  

DMAX(Database; DatabaseField; SearchCriteria)

DMIN  
DMIN calculates the minimum value across the cells (fields) of the specified column that contain 
numeric values, for all rows (database records) that match the specified search criteria. Blank cells 
or cells containing non-numeric characters are not included.

Returns 0 if no matches are found, or if there are no non-zero numeric values in the cells of the 
specified column for the matching records.

Syntax  

DMIN(Database; DatabaseField; SearchCriteria)

DPRODUCT  
DPRODUCT calculates the product of all numeric values in the cells (fields) of the specified 
column, for all rows (database records) that match the specified search criteria. Blank cells or cells 
containing non-numeric characters are not included.

Returns 0 if no matches are found, or if there are no numeric values in the cells of the specified 
column for the matching records.

Syntax  

DPRODUCT(Database; DatabaseField; SearchCriteria)

Freezing And Splitting  
When working with large data it can be difficult to view the information in a
spreadsheet. Fortunately Calc includes two useful tools to help us view the



contents of a spreadsheet with large amount of data that exceed the window
width or height.

•Freeze Rows and Columns
•Split Window

Freeze Rows and Columns  

When freezing a row or column, it has a fixed position in the window when
we scroll horizontally or vertically.

Freeze a rowFreeze a row    

To freeze a row select the row below the one you want to freeze and click the
Freeze Button. The frozen row will be indicated by a black line on the bottom.

Freeze a columnFreeze a column    

To freeze a column select the column on the right and click the Freeze 
Button. The frozen column will be indicated by a black line on the right.



Freeze both a row and columnFreeze both a row and column    

To freeze a row and a column at the same time select the cell that is on the bottom row and on the 
right column and click the Freeze button.

Remove freezingRemove freezing    

When a row or column in a spreadsheet is frozen the Freeze button is highlighted . To revert a row 
or column back to normal state and remove freezing simply click on the Freeze button.

Split windowsSplit windows    
Another useful tool to help you view a sheet is the Split Window tool. Using this tool you can 
divide a sheet to 2 or 4 windows that scroll separately.

Split window horizontallySplit window horizontally    

To split horizontally into two separate windows select a row and click the Split window button. A 
gray line indicates the borders between the two windows.



Split window verticallySplit window vertically    

To split vertically into two separate windows select a column and click the Split window button. A
gray line indicates the borders between the two windows.

Split window into 4Split window into 4    

To split into 4 separate windows select a cell and click the Split window button. A gray line 
indicates the borders between the windows.

Remove the splitRemove the split    

When a sheet is split into separate parts the split button is highlighted. To remove the split simply 
click on the Split Window button.



Sorting And Filtering  
When operating with data in a spreadsheet, we usually require arranging and organising the data 
for better viewing and finding. Furthermore, we can use LibreOffice Calc as a simple database 
tool and ask simple questions to obtain helpful information from our data. This is performed using 
the Sorting and Filtering tools.
 
Sorting and filtering in LibreOffice Calc can be accessed using the Sort and Filter section in 
Standard Toolbar.
 
Step 1:- select range of cell that you want to arrange in sorting order.
Step 2:-then go to data menu – select sort option.
Step 3:- sort dialogue box will appear on your screen in this dialogue box select sortingcriteria that 
you want.
Step 4:- click on OK button.

FILTERINGFILTERING    
When a sheet contains a large amount of data, it can be difficult to find information quickly. In that
case Filters can be used to narrow down the data in your worksheet, allowing you to view only the 
information you need. In other words Filters help you to ask questions to your data and retrieve 
useful information.

Calc provides three types of filter:

•Standard – specifies the logical conditions to filter your data.

•AutoFilter – Automatically filters the selected cell range and creates one-row list boxes 
where you can choose the items that you want to display.

•Advanced –  uses filter criteria from specified cells.

In this lesson we will cover the AutoFilter command



AutoFilterAutoFilter    

The easiest way to apply filters is using the AutoFilter command. In order to use this command you
data must be organized in a table format and meet the following criteria:

•the first row contains column headers. The headers describe the column contents (for 
example name, age, product)

•Every row after the first contains only data. Each data row represents a record of your data 
table.

•All records must be in sequence with no empty records in between.

Create an AutoFilterCreate an AutoFilter    

To create an AutoFilter simply click on the AutoFilter Button. A drop-down arrow will appear in 
the header cell for each column.



Applying a filterApplying a filter    

To apply a filter click on a column's drop-down arrow to bring the filter window. In this window 
you can set the filter criteria. For example to show only the Female persons we deselect the other 
values.
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STANDARD FILTERSTANDARD FILTER    

For more advanced filters click data>more filter>standard filter

To create a standard filter in general you specify the
•Operator. Can be the logical AND or logical OR.

•Field name. This is the name of the column

•Condition. A logical condition (equality, greater, less)

•Value. The value of the filter.

ADVANCE FILTERADVANCE FILTER
When using the advanced filter, the arrows of drop-down menu don't appear, instead we need to 
enter criteria in the scope of criteria. If we want to see, for example, only students who have more 
than 50 points in mathematics then we would define it as follows :

step1:-
MATH MATH

>50 <50

We mark a table in which we want to do the filtering and on tab Data -> More Filter -> Advanced 
Filter. The dialog box will then appear and then we bring our criteria in it, or in this case in the 
range of criteria we import table with conditions that we have defined, and then click OK 



now select the condition which is created in step 1 in advanced filter’s expand and the shrink it you
get the result for math which is >50 and<100:- here is the result

Goal Seek  
Usually, you create a formula to calculate a result based upon existing data. LibreOffice Calc 
includes tools to help you experiment and answer questions with your data, even when the data is 
incomplete. In this lesson, you will learn how to use a what-if analysis tool called Goal Seek.

What Is Goal SeekWhat Is Goal Seek    

Let's examine a simple example. A student tracks his final exam grades in school using a 
spreadsheet shown in the image below. So far he has received all grades for each subject except the
one marked with a question mark.

Currently the average grade is 62 but he needs at least a 65 to pass the class. What is the minimum 
score he must achieve in the Information Technology exam in order to pass the class? Instead of 
manually trying random values he can use Goal Seek to find out what grade he needs on the final 
exam to pass.



Using Goal SeekUsing Goal Seek    

Goal Seek tool need three parameters

• The formula cell. This is the cell contains the formula we want to resolve

• The target value. The required value that we want our formula to to resolve to (in our 
example 65)

• The variable cell. The cell that contains the unknown data that we want to find a value that 
meets the requirements.

To Use Goal Seek:To Use Goal Seek:

1. Fill the cell with the unknown data with a 0 (or any other value). The Average will change but 
ignore it.

Normally we would not need to do this but it seems to be a bug in LibreOffice Calc that crashes 
Goal Seek tool when the value cell is empty.

2. Select the cell containing the Formula (in our example the Average grade) and Choose Tools > 
Goal Seek from the main menu.

3. In the Goal Seek dialog window fill in the parameters. The Formula cell is already filled in. 
Type in the Target value and click the Variable cell to autofill the cell reference value in the 
dialog.



4. Goal Seek now calculates and displays the Result in another pop up dialog. Choose Yes to insert 
the result to the variable cell

Now the student knows that he must achieve a grade 84 or greater in the IT exam in order to pass 
the course.



Pivot Tables  

Pivot Tables are one of the most powerful and useful tools in Calc. With this tool you can 
combine, compare, and analyzing large amounts of data easily. Using Pivot Tables, you can view 
different summaries of the source data, display the details of areas of interest, and create reports.

Why use Pivot TablesWhy use Pivot Tables    
To better understand pivot tables let's examine an example. The spreadsheet below records sales 
from a company. To answer the question what is the amount sold by each salesperson it could be 
time consuming and difficult because each salesperson appears on multiple rows. We could use the
Subtotal command to find the total for each salesperson, but we would still have a lot of data to 
work with.

Creating Pivot TableCreating Pivot Table    
Pivot table can created on data that have the table format which means no empty columns or rows 
and the first row contains the column names.

To create a Pivot Table:

Select only one cell from your data.

Choose the Insert Pivot Table command from the main menu or click the   from the Standard 
toolbar.

Calc automatically selects all the cells and opens the Select Source dialog. Click OK to continue



In the Pivot Table Layout Dialog
you set up the pivot table. In
general you drag fields from the
Available Fields pane to the other
white areas.

Drag the employee field to the Row fields 
are and the sales field to the Data Fields area
and click OK.



The pivot table is created in a new sheet. Now we get a summary of the sum of sales for each 
employee.

Pivot Table LayoutPivot Table Layout    
The layout of the pivot table is divided into 4 parts: Rows, Columns, Data and Page. If you 
understand the layout you will be able to create more complex pivot tables and extract important 
information from your data.

The Rows Area

When you drag a field into the Rows area of the pivot table, all the unique values in that field will 
be displayed in the first column of the pivot.  The pivot table removes all the duplicates in the field 
(column of source data) and only displays the unique values. In the example we used the employee 
field for the Row area.

The Data Area

The Values area displays the data (values) that we want to summarize in our pivot table report. 
When you drag a field into the Values area, the pivot table will automatically sum or count the data
in that field.  If the data in the field contains numbers, then the sum will be calculated.  If the data 
contains text or blanks, then the count will be calculated.



The Columns Area

The Columns area works just like the Rows area. It lists the unique values of a field in the pivot 
table. The only difference is that it lists the values across the top row of the pivot table. In the 
example above we used the category field in the Columns Area.

Page Area

Fields that are placed into the Page Fields area appear in the result above as a drop down list. The 
summary in your result takes only that part of your base data into account that you have selected. 
In the example above we used the region field in the Page Fields Area.

Edit a pivot TableEdit a pivot Table    
The real value of Pivot Tables is that they can quickly pivot (or reorganize) your data, allowing you
to examine them in multiple ways. Pivoting data can help you answer different questions and 
discover new trends and patterns.To edit a pivot table layout, right click anywhere inside the Pivot 
Table and select Edit Layout from the context menu.

The Pivot Table Layout dialog window opens and allows you to delete, add or reorder fields in 
the layout.



In our initial example we add the region fields to the Row area and the category fields to the Page 
area.

Updating the Pivot TableUpdating the Pivot Table    
A Pivot Table will not update automatically if you change any of the data in your source sheet. To 
update, right click anywhere inside the Pivot Table and select Refresh from the context menu.

Data Fields calculationData Fields calculation    
By default numerical fields that are placed in the Data area are summarized with 
the SUM function. For text fields the default calculation is the COUNT function. This is why it's 
important to make sure you don't mix data types for value fields. You can change the calculation of
a Data field in the Pivot Table Layout window.

To change the calculation double click on the field in the Data area.



In the Data Field pop up window select the function and click OK

The following pivot table example uses the COUNT function for the category field

Delete a Pivot TableDelete a Pivot Table    
To delete a pivot table, right click anywhere inside the Pivot Table and select Delete from the 
context menu.



Apply Data Validation To Cells  
1.Select Data >VALIDITY
2.On the Settings tab, under Allow, select an option:

Whole Number - to restrict the cell to accept only whole numbers.
Decimal - to restrict the cell to accept only decimal numbers.
List - to pick data from the drop-down list.
Date - to restrict the cell to accept only date.
Time - to restrict the cell to accept only time.
Text Length - to restrict the length of the text.
Custom – for custom formula.

3. Under Data, select a condition.

4.Set the other required values based on what you chose for Allow and Data.

5.Select the Input Message tab and customize a message users will see when entering data.

6.Select the Show input message when cell is selected checkbox to display the message when 
the user selects or hovers over the selected cell(s).

7.Select the Error Alert tab to customize the error message and to choose a Style.

8.Select OK.

9.Now, if the user tries to enter a value that is not valid, an Error Alert appears with your 
customized message.

How to create a chart
To create a chart in LibreOffice Calc, follow these steps: 
Select the data that you want to include in the chart.

1. Click on the "Insert" menu and select "Chart".
2. In the "Chart Type" dialog box, choose the type of chart you want to create and click 

"Next".
3. In the "Data Range" dialog box, verify that the correct data range is selected and click 

"Next".
4. In the "Chart Elements" dialogue box, select the chart elements that you want to include and

customize the chart as desired.
5. Click "Finish" to create the chart.

You can further customize the chart by using the "Format" menu and the "Chart Area" dialogue 
box.
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